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Introduction  

This user guide is split in two parts, first covering the Midi Fighter Twister hardware, then the 

second covering the Midi Fighter Utility and all relevant device settings.  

If you are simply looking to learn how to set up and use an existing mapping in either Traktor 

or Ableton, please refer to the quick start guides, these are both available here.  

djtechtools.com/midifighterhelp 


Nomenclature  

The Musical Instrument Device Interface (MIDI) protocol at its most basic level describes 16 

channels, each consisting of 128 Notes, and 128 Control Change (CC) messages.  

This user guide and the Midi Fighter Utility refers to these 16 channels as channels 0 through 

15, the notes as notes 0 through 127, and the control change messages as CC’s 0 through 

127.  
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The Midi Fighter Twister Hardware  

This section describes the hardware & MIDI operation of the Midi Fighter Twister in detail and 

should be used as a reference when creating your own MIDI mapping in your software of 

choice.  

This section assumes that the reader is already familiar with the basics of the MIDI protocol.  

Introduction  

The Midi Fighter Twister consists of 16 encoders each with an integrated push switch, and 6 

side buttons.  

Each encoder has a display consisting of 11 white LEDs to indicate the current control value 

or position, a large RGB segment which indicates the switch state, and a red/blue LED to 

indicate detent state.  

The Midi Fighter Twister firmware makes it possible to access up four virtual ‘Banks’ or 

‘groups’ of encoders. To access the virtual banks ensure that some of the side buttons are 

configured for bank change actions in the Midi Fighter Utility Software.  

Each of the 16 encoders will send a different message in each bank, allowing access of up to 

64 unique encoder & switch controls across the 4 banks.  

For a full description of the bank operation refer to the virtual bank section. 
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Encoders  

Each encoder sends a CC, note, or relative encoder message depending on its configuration, 

with the current value indicated on its 11 LED display. There are a variety of user configurable 

display types, these are covered in the Midi Fighter Utility section of this user guide.  

It is possible to sync the display value of the CC or note to the parameter it is controlling in 

your software of choice. Simply map the MIDI OUT for that parameter to the same MIDI 

number on channel 0.  

Using the Midi Fighter Utility it is possible to remap the MIDI channel and number for each 

encoder.  

  

Encoders Push Switches  

Each encoder also has an integrated push switch, this will send a CC (default), a Note 

message, or perform some special action depending on its configuration.  

Please refer to the Midi Fighter Utility section of the manual for a full description of the various 

available switch actions.  

The large RGB segment at the 6 o’clock position of each encoder display is used to indicate 

the state of the switch control, using the Midi Fighter Utility it is possible to set the color for 

both the inactive (not pressed) and the active (pressed) switch state.  

It is also possible to override the color of the RGB segment by sending a MIDI message (Note 

or CC) of the same MIDI number, on channel 1. Sending a message of value 0 will force it to 

its inactive color state, while sending a message of value 127 will force it to it's active color 

state. Any value between 0 and 127 will set it to a color as shown in the scale below.  

�  
1 	 	 	 	 	 	 	 	 	 	 	 	         126 
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Setting RGB / Indicator Segment Animation State  

By sending MIDI message of a particular value it is also possible to set a variety of animation 

states for each ring, these animations modify the current color state of the ring illumination.  

The available animation states are,  

RGB Strobe | Value 1 - 8  

Allows the user to gate (flash) the current color at one of 8 different rates. If a MIDI clock 

signal is present the timing is derived from that, otherwise the timing is based on a half 

second interval which is the equivalent of 120 BPM. This is useful for creating warnings, 

for example in Traktor you could map the Track End Warning output to flash an LED when 

the track is nearing its end.  

RGB Pulse | Value 9 - 16  

Similar to the Gate animation this allows the user to pulse the current color at one of 7 

different rates. If a MIDI clock is present the timing is derived from that otherwise the 

timing is based on a half second interval which is the equivalent of 120 BPM. This 

animation is useful for creating subtle alerts, for example in Traktor you could map the 

Loop On output to control the pulse rate to reflect that the loop is active, and what length 

it is set to. 

RGB Brightness 17-47  

Allows the user to control the brightness of the RGB LEDs. Very useful to give or take 

emphasis from a parameter. I.e. showing a parameter in a off state while color is still 

visible or VU meters. 

Indicator Strobe | Value 49 - 56 

Allows the user to gate (flash) the current color at one of 8 different rates. If a MIDI clock 

signal is present the timing is derived from that, otherwise the timing is based on a half 

second interval which is the equivalent of 120 BPM. This is useful for creating warnings, 

for example in Traktor you could map the Track End Warning output to flash an LED when 

the track is nearing its end.  

Indicator Pulse | Value 57 - 64 

Similar to the Gate animation this allows the user to pulse the current color at one of 8 

different rates. If a MIDI clock is present the timing is derived from that otherwise the 

timing is based on a half second interval which is the equivalent of 120 BPM. This 

animation is useful for creating subtle alerts, for example in Traktor you could map the 

Loop On output to control the pulse rate to reflect that the loop is active, and what length 

it is set to. 
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Indicator Brightness 65 - 95  

Allows the user to control the brightness of a RGB LEDs. Very useful to give or take 

emphasis from a parameter. I.e. showing a parameter in a off state while color is still 

visible or VU meters. 

RGB Rainbow | Value 127  

Forces the LED to display a rainbow animation.  

To set the animation state of a given encoder send a CC or Note On message of the same 

number, but on channel 6. If you’d like to send an animation to the RGB LED do so on 

channel 3. 

I.e. To set the animation state of the first encoder to Gate 1/4 send a Ch6 CC 0 of 

value 5.  

It is important to note that the MIDI color setting and MIDI animation setting can be used in 

conjunction.  

I.e. To set the first encoder switch to yellow flashing at a rate of 1/2 first send the 

color information with a Ch2 CC0 of value 64, then the animation setting with a 

Ch3 CC0 of value 4.  

If the encoder switch MIDI channel or number settings are changed from default the color 

and animation controls will change, i.e., if you change Encoder 1 in Bank 1 from channel 1 

number 0 to channel 7 number 8 it will send MIDI on channel 7 number 8 and expect MIDI 

out on the same number and channel. 

Be aware that if you change from the defaults it could conflict with other MIDI sent by the 
Twister. Check the Appendix for a full listing of all the default MIDI messages for the Twister. )
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Side Buttons  

Using the utility the 6 side buttons can be configured to send notes, CCs, or perform certain 

internal functions like changing the bank selection.  

If a side button is set for MIDI function the pitch of the note or CC number will be unique in 

each virtual bank. This can be disabled by unchecking the “Bank Side Button” check box in 

the Utility.  

Side button MIDI messages are sent on the Global Channel (Ch.4 by default).  

Please refer to the utility section of this user manual for a complete description of the various 

side button functions.  

In Appendix 1 you will find a complete list of MIDI data for each side button in each bank.)
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Virtual Bank Operation  

The Midi Fighter Twister makes it possible to access up to four virtual banks. In each bank 

the encoders, encoder switches and side buttons* will send different MIDI Notes or CC’s.  

To switch between virtual bank the side buttons must be configured to allow bank switching. 

By default the middle left side button decrements the bank selection, and the middle right 

side button increments the bank selection. Please refer to the side button section of this 

manual for further information.  

*Side buttons can be set to not change with bank by disabling the “Bank Side Buttons” 

option in the Utility.  

Advanced Bank Control  

It is also possible to use MIDI to read and set the currently selected bank.  

When the virtual bank selection changes the Midi Fighter Twister sends a Note On to indicate 

a new bank has been selected. It will also send a Note Off to indicate the previously selected 

bank is no longer active. By default the bank selection notes are sent on MIDI Channel 4 but 

this can be set to a different channel using the Midi Fighter Utility.  

I.e. When changing from Bank 1 to Bank 2 the Midi Fighter Twister will send a 

Ch4 CC0 Note Oû followed by a Ch4 CC1 Note On.  

By sending Note On messages to the Midi Fighter Twister it is also possible to force it to 

automatically change to a specific bank.  

i.e. To force a change to Bank 2 send a Ch4 CC1 Note on  

Bank Change Notes 

Bank 1 | Ch4 CC0 

Bank 2 | Ch4 CC1 

Bank 3 | Ch4 CC2 

Bank 4 | Ch4 CC3 
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The Midi Fighter Utility Software  

This section covers the Midi Fighter Utility software. This is an application for PC & Mac that 

can be used to control, configure, and update your Midi Fighter Twister.  

Getting Started  

The Midi Fighter Utility software can be downloaded using the following links.  

Download For Mac  

Download For PC  

Once this has been installed you will find a shortcut on your desktop if using PC, or you can 

find the utility in your Applications folder if using Mac.  

To get started launch the application and connect your Midi Fighter Twister to a spare USB 

port.  

Note: If the Midi Fighter Utility does not detect the Midi Fighter Twister please make sure all 
other MIDI software has been shut down, then restart the utility and reconnect the device. 
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Firmware Update  

It is important to ensure your device is loaded with the latest firmware. You can tell if you 

need to update your firmware by looking at the device information section. 

If the device firmware needs to be updated the “Update Firmware” button will display in 

orange, and the text “new firmware available” will display in red. If the firmware is already up 

to date the ‘Update Firmware’ button will display in grey and the text “up to date” will appear 

in green.  

To update the device firmware simply click the update firmware button.  

Note: When updating the firmware do not connect the Midi Fighter Twister via a USB HUB, 

this may lead to a bricked device.  

Performing a Factory Reset  

Using the Midi Fighter Utility it is possible to restore all device settings and color information 

back to the factory defaults. If you are having trouble with your Midi Fighter Twister this can 

be a good place to start when diagnosing the problem.  

To perform a factory reset connect your Midi Fighter Twister to the Utility and in the menu bar 

click,  

Tools>Midi Fighter>Factory Reset  

Importing & Exporting Settings  

It is possible to import and export device settings, this is useful for saving and sharing device 

settings and color information used for a particular mappings.  

To export your settings click File>Export Settings and enter the name you wish to save the file 

under.  

To import your settings click File>Import Settings and select the settings file you wish to load.  

Note: Once these settings are loaded you must still press “Send to Midi Fighter” to save 
them to the device.  
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Configuring your Midi Fighter Twister  

There are two different types of settings for the Midi Fighter Twister, global settings and 

encoder settings. Global settings are not related to any particular encoder, while the encoder 

settings are unique for each of the 16 encoders in each of the 4 virtual banks.  

The global settings are found under the “Global Settings” tab in the left hand pane of the 

utility, while the encoder settings for the currently selected encoder are displayed in the 

“Encoder Settings” tab.  

Any edits you make must be saved to the device by clicking the large blue ‘Send To Midi 

Fighter’ button. 

 
Editing Encoder Settings  

The Encoder Settings can be found under the “Encoder Settings” tab in the left hand pane of 

the utility and are unique to each encoder in each bank.  

To select an encoder for editing first select its bank by clicking one of the bank buttons, and 

then select the encoder by clicking on it, the circular blue cursor indicates the currently 

selected encoder.  

Editing Encoder Color Settings  

Each encoder has two different color settings types, On Color (switch is pressed) and Off 

Color (switch is released). The color palette at the top right of the window is used to set the 

color of the currently selected encoder, and color setting type. To change which color setting 

type is being edited use the buttons at the bottom right of the window.  

Editing Multiple Encoders  

It is possible to set certain settings for multiple encoders at the same time, this is called 

“Multiple Edit” mode. To access this mode click the ‘Multiple’ button in the lower right hand 

side of the utility. You can now select multiple encoders (in the same bank only) and modify 

the available settings in the “Multiple Edit” tab on the left hand pane of the utility.  

To save any edits made in Multiple Edit mode you must press the ‘Send to Midi Fighter’ 

button, to cancel without applying any changes just click ‘Cancel’ and it will discard the 

changes and return to single edit mode. 
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The Global Settings 

The following is a description of all available global settings. 

System MIDI Channel 

Allows you to customize the MIDI channel where global device messages such as Bank 

Navigation is sent. It’s 4 by default. If you change either the System or Encoder’s channels 

make sure they don’t overlap to avoid crosstalk. 

Super Knob Start Point 

Defines the velocity value at which all Super Knobs engage. 

Super Knob End Point 

Defines the velocity value at which all Super Knobs end. 

RGB LED Brightness 

Defines the maximum brightness for all RGB LEDs. 

Indicator Global Brightness 

Defines the maximum brightness for all Indicator LEDs. 

Side Button Function 

Allows you to assign the different messages and functionality available for each of the 6 

side buttons available on the Midi Fighter. The different  

• CC Hold 

• CC Toggle 

• Note Hold 

• Note Toggle 

• Shift Page A 

• Shift Page B 

• Previous Bank 

• Next Bank 

• Bank 1-4 

• Cycle Banks 
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The Encoder Settings  

The following is a description of all available encoder settings.  

Enable Detent  

If enabled the encoder will behave like a potentiometer with a center detent. 

Commonly used for controlling EQ or filter settings. In this mode it’s LED display will 

start from the middle rather than the left hand side, and when its value is 50% (a MIDI 

Value of 64) the LED will change color to indicate this.  

Detent Color  

This can be used to change the color of the detent indicator, which is a red blue LED. 

A value of 0 will select red, while a value of 127 will select blue, and any value between 

will be a mix of the two.  

Sensitivity  

There are two sensitivity settings, ‘Responsive’ for which 270 degrees of rotation 

changes the CC by the full MIDI range of 127, or ‘High Resolution’ which gives the 

highest resolution control.  

Indicator Type  

The indicator type setting changes how the encoder value is displayed on the LED 

ring. There are three options; Dot which is a single LED, Bar which is a bar graph style 

display, and Blended Bar where the leading LED changes in brightness as the position 

changes, this gives the most detailed indication of position.  

   )
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Enable Super Knob  

If enabled the encoder will send a secondary CC over the range specified by the Super Knob 

Start & End points in the Global Options.  

 
Encoder Switch Action Type  

Each encoder switch can be set to perform one of a range of actions.  

CC Hold  

The switch will send a CC of value 127 when pressed and a CC of value 0 when released.  

CC Toggle  

The switch will alternate between sending a CC of value 127 and a CC of value 0 each 

time it is pressed.  

Note Hold  

The switch will send a Note On of velocity 127 when pressed and a Note Off of velocity 0 

when released.  

Note Toggle  

The switch will alternate between sending a Note On and a Note Off each time it is 

pressed.  

Reset Encoder Value  

When pressed the switch will reset the encoder value to 0, or 64 if Detent is enabled. In 

this mode the switch also sends a MIDI message as if it where configured for CC hold.  

Encoder Fine Adjust  

When pressed the encoder sensitivity is reduced allowing fine adjustment.  

Shift Encoder Hold  

While the switch is pressed the encoder sends a secondary value, allowing one encoder 

to control two knobs independently. These messages are sent on Ch.5 

Shift Encoder Toggle  

When pressed the switch toggles between primary and secondary (shift) encoder values. 

These messages are sent on Ch.5 
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Encoder MIDI Type  

Each encoder can be configured to send either of the following MIDI messages  

Note  

The encoder sends Note On messages where the velocity corresponds to the Encoder 

Value.  

CC  

The encoder sends Control Change messages with a value corresponding to the Encoder 

Value.  

Enc 3FH/41H  

The encoder sends relative Control Change messages, a value of 65 is sent for each 

clock wise step, and a value of 63 is sent for each anti-clockwise step.  

Encoder & Encoder Switch MIDI Number & Channel  

You can set the MIDI number (pitch if configured as a Note) and Channel for each encoder 

and encoder switch in each bank. Be aware that if you change from the defaults it could 

conflict with other MIDI sent by the Twister. Check the appendix for a full listing of all the 

default MIDI messages for the Twister. 

These are the default channels used for each of Twister’s messages. 

" Channel 1: Encoders & LED Rings 

" Channel 2: Encoder Switches (RGB) 

" Channel 3: Encoder Switches animations & brightness 

" Channel 4: System MIDI Channel (Banks & Side Buttons) 

" Channel 5: Shift Encoders & LED Rings 

" Channel 6: Encoder LED Ring animations & brightness 

" Channel 8: Sequencer)
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Appendix 1 

Bank 1 MIDI 

* Side Switch MIDI only changes with bank when the “Bank Side Button” option is enabled. 

* Encoder Switch MIDI type defaults to CC  

Control Ch CC # Note

LH Side Switch 1* System (4) 8 G#-1

LH Side Switch 2* System (4) 9 A-1

LH Side Switch 3* System (4) 10 A#-1

RH Side Switch 1* System (4) 11 B-1

RH Side Switch 2* System (4) 12 C0

RH Side Switch 3* System (4) 13 C#0

Control Enc Ch Enc CC# Switch Ch Switch CC Switch Note*

Encoder 1 0 0 1 0 C-1

Encoder 2 0 1 1 1 C#-1

Encoder 3 0 2 1 2 D-1

Encoder 4 0 3 1 3 D#-1

Encoder 5 0 4 1 4 E-1

Encoder 6 0 5 1 5 F-1

Encoder 7 0 6 1 6 F#-1

Encoder 8 0 7 1 7 G-1

Encoder 9 0 8 1 8 G#-1

Encoder 10 0 9 1 9 A-1

Encoder 11 0 10 1 10 A#-1

Encoder 12 0 11 1 11 B-1

Encoder 13 0 12 1 12 C0

Encoder 14 0 13 1 13 C#0

Encoder 15 0 14 1 14 D0

Encoder 16 0 15 1 15 D#0
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Bank 2 MIDI 

* Side Switch MIDI only changes with bank when the “Bank Side Button” option is enabled. 

* Encoder Switch MIDI type defaults to CC  

Control Ch CC # Note

LH Side Switch 1* System (4) 14 D0

LH Side Switch 2* System (4) 15 D#0

LH Side Switch 3* System (4) 16 E0

RH Side Switch 1* System (4) 17 F0

RH Side Switch 2* System (4) 18 F#0

RH Side Switch 3* System (4) 19 G0

Control Enc Ch Enc CC# Switch Ch Switch CC Switch 

Note*

Encoder 1 0 16 1 16 E0

Encoder 2 0 17 1 17 F0

Encoder 3 0 18 1 18 F#0

Encoder 4 0 19 1 19 G0

Encoder 5 0 20 1 20 G#0

Encoder 6 0 21 1 21 A0

Encoder 7 0 22 1 22 A#0

Encoder 8 0 23 1 23 B0

Encoder 9 0 24 1 24 C1

Encoder 10 0 25 1 25 C#1

Encoder 11 0 26 1 26 D1

Encoder 12 0 27 1 27 D#1

Encoder 13 0 28 1 28 E1

Encoder 14 0 29 1 29 F1

Encoder 15 0 30 1 30 F#1

Encoder 16 0 31 1 31 G1
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Bank 3 MIDI 

* Side Switch MIDI only changes with bank when the “Bank Side Button” option is enabled.  

* Encoder Switch MIDI type defaults to CC  

Control Ch CC # Note

LH Side Switch 1* System (4) 20 G#0

LH Side Switch 2* System (4) 21 A0

LH Side Switch 3* System (4) 22 A#0

RH Side Switch 1* System (4) 23 B0

RH Side Switch 2* System (4) 24 C1

RH Side Switch 3* System (4) 25 C#1

Control Enc Ch Enc CC# Switch Ch Switch CC Switch Note*

Encoder 1 0 32 1 32 G#1

Encoder 2 0 33 1 33 A1

Encoder 3 0 34 1 34 A#1

Encoder 4 0 35 1 35 B1

Encoder 5 0 36 1 36 C2

Encoder 6 0 37 1 37 C#2

Encoder 7 0 38 1 38 D2

Encoder 8 0 39 1 39 D#2

Encoder 9 0 40 1 40 E2

Encoder 10 0 41 1 41 F2

Encoder 11 0 42 1 42 F#2

Encoder 12 0 43 1 43 G2

Encoder 13 0 44 1 44 G#2

Encoder 14 0 45 1 45 A2

Encoder 15 0 46 1 46 A#2

Encoder 16 0 47 1 47 B2
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Bank 4 MIDI 

* Side Switch MIDI only changes with bank when the “Bank Side Button” option is enabled.  

* Encoder Switch MIDI type defaults to CC  

Control Ch CC # Note

LH Side Switch 1* System (4) 26 D1

LH Side Switch 2* System (4) 27 D#1

LH Side Switch 3* System (4) 28 E1

RH Side Switch 1* System (4) 29 F1

RH Side Switch 2* System (4) 30 F#1

RH Side Switch 3* System (4) 31 G1

Control Enc Ch Enc CC# Switch Ch Switch CC Switch Note*

Encoder 1 0 48 1 48 C3

Encoder 2 0 49 1 49 C#3

Encoder 3 0 50 1 50 D3

Encoder 4 0 51 1 51 D#3

Encoder 5 0 52 1 52 E3

Encoder 6 0 53 1 53 F3

Encoder 7 0 54 1 54 F#3

Encoder 8 0 55 1 55 G3

Encoder 9 0 56 1 56 G#3

Encoder 10 0 57 1 57 A3

Encoder 11 0 58 1 58 A#3

Encoder 12 0 59 1 59 B3

Encoder 13 0 60 1 60 C4

Encoder 14 0 61 1 61 C#4

Encoder 15 0 62 1 62 D4

Encoder 16 0 63 1 63 D#4
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Shift Page A 

Control Ch Switch Note*

Encoder 1 System (4) G#1

Encoder 2 System (4) A1

Encoder 3 System (4) A#1

Encoder 4 System (4) B1

Encoder 5 System (4) C2

Encoder 6 System (4) C#2

Encoder 7 System (4) D2

Encoder 8 System (4) D#2

Encoder 9 System (4) E2

Encoder 10 System (4) F2

Encoder 11 System (4) F#2

Encoder 12 System (4) G2

Encoder 13 System (4) G#2

Encoder 14 System (4) A2

Encoder 15 System (4) A#2

Encoder 16 System (4) B2
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Shift Page B 

Control Ch Switch Note*

Encoder 1 System (4) C3

Encoder 2 System (4) C#3

Encoder 3 System (4) D3

Encoder 4 System (4) D#3

Encoder 5 System (4) E3

Encoder 6 System (4) F3

Encoder 7 System (4) F#3

Encoder 8 System (4) G3

Encoder 9 System (4) G#3

Encoder 10 System (4) A3

Encoder 11 System (4) A#3

Encoder 12 System (4) B3

Encoder 13 System (4) C4

Encoder 14 System (4) C#4

Encoder 15 System (4) D4

Encoder 16 System (4) D#4
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Appendix 2 

Animation Settings
Velocity / CC Value Animation Setting

0 None -

1 RGB Gate Toggles on every 8 Beats

2 RGB Gate Toggles on every 4 Beats

3 RGB Gate Toggles on every 2 Beats

4 RGB Gate Toggles on every Beat

5 RGB Gate Toggles every 1/2 Beat

6 RGB Gate Toggles every 1/4 Beat

7 RGB Gate Toggles every 1/8 Beat

8 RGB Gate Toggles every 1/16 Beat

9 None -

10 RGB Pulse Pulses on every 8 Beats

11 RGB Pulse Pulses on every 4 Beats

12 RGB Pulse Pulses on every 2 Beats

13 RGB Pulse Pulses on every Beat

14 RGB Pulse Pulses every 1/2 Beat

15 RGB Pulse Pulses every 1/4 Beat

16 RGB Pulse Pulses every 1/8 Beat

17 RGB Brightness 0 - Off

18 RGB Brightness 1

19 RGB Brightness 2

20 RGB Brightness 3

21 RGB Brightness 4

22 RGB Brightness 5

23 RGB Brightness 6

24 RGB Brightness 7

25 RGB Brightness 8

26 RGB Brightness 9

27 RGB Brightness 10

28 RGB Brightness 11

29 RGB Brightness 12

30 RGB Brightness 13
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31 RGB Brightness 14

32 RGB Brightness 15 - Mid

33 RGB Brightness 16

34 RGB Brightness 17

35 RGB Brightness 18

36 RGB Brightness 19

37 RGB Brightness 20

38 RGB Brightness 21

39 RGB Brightness 22

40 RGB Brightness 23

41 RGB Brightness 24

42 RGB Brightness 25

43 RGB Brightness 26

44 RGB Brightness 27

45 RGB Brightness 28

46 RGB Brightness 29

47 RGB Brightness 30 - Max

48 None -

49 Indicator Gate Toggles on every 8 Beats

50 Indicator Gate Toggles on every 4 Beats

51 Indicator Gate Toggles on every 2 Beats

52 Indicator Gate Toggles on every Beat

53 Indicator Gate Toggles every 1/2 Beat

54 Indicator Gate Toggles every 1/4 Beat

55 Indicator Gate Toggles every 1/8 Beat

56 Indicator Gate Toggles every 1/16 Beat

57 Indicator Pulse Pulses on every 8 Beats

58 Indicator Pulse Pulses on every 4 Beats

59 Indicator Pulse Pulses on every 2 Beats

60 Indicator Pulse Pulses on every Beat

61 Indicator Pulse Pulses every 1/2 Beat

62 Indicator Pulse Pulses every 1/4 Beat

63 Indicator Pulse Pulses every 1/8 Beat

Velocity / CC Value Animation Setting
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64 Indicator Pulse Pulses every 1/16 Beat

65 Indicator Brightness 0 - Off

66 Indicator Brightness 1

67 Indicator Brightness 2

68 Indicator Brightness 3

69 Indicator Brightness 4

70 Indicator Brightness 5

71 Indicator Brightness 6

72 Indicator Brightness 7

73 Indicator Brightness 8

74 Indicator Brightness 9

75 Indicator Brightness 10

76 Indicator Brightness 11

77 Indicator Brightness 12

78 Indicator Brightness 13

79 Indicator Brightness 14

80 Indicator Brightness 15 - Mid

81 Indicator Brightness 16

82 Indicator Brightness 17

83 Indicator Brightness 18

84 Indicator Brightness 19

85 Indicator Brightness 20

86 Indicator Brightness 21

87 Indicator Brightness 22

88 Indicator Brightness 23

89 Indicator Brightness 24

90 Indicator Brightness 25

91 Indicator Brightness 26

92 Indicator Brightness 27

93 Indicator Brightness 28

94 Indicator Brightness 29

95 Indicator Brightness 30 - Max

127 Rainbow Cycle Cycle rate fixed at 4 Beats

Velocity / CC Value Animation Setting
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Note: Animations are sent on the same CC as the Switches for both encoders and switches 

but on Ch.3 for RGB LEDs and Ch. 6 for LED Rings (e.g. Animations for the top left button 

and encoder on Bank 1 are sent to CC0 Ch3 and CC0 Ch6 respectively)
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